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Features of the EMUL-ST10-OCELite-PC

The  EMUL-ST10-OCELite-PC emulator supports devices, which have OCELite  support.  The emulator
provides loading of code, Run Control, Shadow Memory and Events.

The emulator connects to the target board using a 20-pin type “A” connector as described by NEXUS, see figure 1
for a picture of the EMUL-ST10-OCELite pod. The connection to the host PC is with the USB Port.

The user interface software is named Seehau, and it provides multiple views of the code;  C/
C++, C/C++ mixed with assembly and pure assembly.  Seehau supports symbolic debugging for Keil and Altium.

The run control provides Source Step Into and Over, Assembly Step
Into and Over, and Return Step. There is a facility to preset register
values and view data in multiple formats and windows.

The Data Window displays in multiple formats including:  ASCII,
Binary, HEX, Graphs, Gauges and custom defined formats.  The Data
Windows  have access to different memory areas including:  Code,
Data, Register and Shadow RAM.  The Shadow RAM will reflect
changes to Data Memory while the target is running.

Emulator Hardware

The EMUL-ST10-OCELite-PC hardware is comprised of two parts, the OCELite Hardware interface, that
connects to the host PC through the USB Port, and the ADPT20CE cable adapter.  The ADPT20CE has the 20
pin NEXUS type “A” connector as well as an Event IN, Event OUT and two GND Pins (see figure 2).
The target connector is an AMP connector Part #104549-2.  The target connector layout with the pin assignments
is shown in figure 3.

Figure 1. EMUL-ST10-OCELite-PC
target connection

Figure 2. Emulator hardware Figure 3. Target connector layout

Not Used
GND
GND
GND
GND
GND
GND
GND
GND
*VREF

*RDY
*EVTO
Not Used
TDO
TCK
TDI
TMS
*TRST
*EVTI
*RESET

An * indicates an active low signal

Pin 19 Pin 20

Pin 1 Pin 2
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System Installation

The purpose of this document is to get your emulator up and running quickly.  We have outlined 4 steps to accom-
plish this. The first step is to install the software, then the hardware, then configure the software and finally run a
program.

Note: The software must be installed first before connecting the hardware or the USB driver will not be present.

Install the Software

To install the Seehau software, do the following:
1. Place the Seehau CD into your CD ROM drive.  The installation process will start automatically.

2. After Autorun executes the software installer window will appear.

3. Click  Install Seehau Interface for EMUL-ST10,  this will start a standard Install Shield installation.

4. Follow the instructions that appear on your screen. At the end of the installation program the setup complete
dialog box appears allowing you to start the Seehau Configuration Program.  Before selecting the Launch Seehau
OCELite Configuration, perform the Install the Hardware step outlined below.

Install the Hardware

To install the EMUL-ST10-OCELite-PC hardware, do the
following:
1. Plug the 20-pin NEXUS type “A” connector onto the NEXUS connector on your target board, the red wire of
the ribbon cable is pin 1 (see figure 4).

2. Plug the “B” connector of the USB cable into the connector of the EMUL-ST10-OCELite-PC.

3. Plug the other end of the USB cable (the “A” connector) into the USB port on your PC.

Figure 4.
 EMULST10-OCELite target connection
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Configure the Software

To  start the Seehau Configuration program, do the following:

1. From the Start menu, select Programs.

2. Select Seehau ST10. Then click Config to open the Emulator Configuration window displaying the Connect
tab (see figure 5).

3.  The interface type for the EMUL-ST10-OCELite-PC emulator is USB, which is the one selected in figure 5.
Click the next button to proceed.

4.  Select the CPU-OCELite. Click next to proceed (see figure 5).

Figure 5. Emulator configuration window
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5.  The Emulator Configuration Hdw Config tab will appear as in figure 6.   Proceed by clicking Finish.

6. Click Yes to start the emulator.

Note: Refer to chapter 2 in this manual for a detailed description of the emulator configuration options.

Configuring the Emulator For Your Target

The microcontroller will reset to different addresses depending upon the state of the EA pin at reset.  If the  EA pin
is low (Eternal mode), than at reset the PC will contain address 000000H, which is the address of external memory.
If the EA pin is high (Single Chip mode), then at reset the PC will contain the address C00000H, which is the
address of the on chip 512K SRAM.

To use the example program OCELite.abs some of the registers will need to have particular values at reset.  The
ability of the Seehau debugger to preset register values makes this fairly  simple to accomplish.

Figure 6. Emulator Hdw Con fig tab
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Register Values at Reset

There are two registers, the PC (Program Counter) and the Vecseg (Vector Segment Register), that need to have
specific values for use with the OCELite.abs example.

The PC is set on the Emulator Configuration screen.  This is accessed from the main menu bar by selecting
CONFIG->Emulator.  When the dialog appears click on the MISC Setup tab.  Check the Program Counter box
and enter C00000.  This is shown in figure 7.

Figure 7. Emulator Misc Setup tab
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The *vecseg register is set from the SFR
window.  This method can be used to
preset any register.  From the main menu
bar select View->S F Regs (see figure 8).
Click the + next to LONDONCORE,
after the list expands select *vecseg, this is
shown highlighted in figure 8.  Next click
the right arrow under selected, then click
add and select new window.  A new
register window will appear containing the
*vecseg register.  To set value at reset,
right-click on *vecseg and select Change
Attributes.  The window in figure 9 now
appears.  Check the Enable Reset Value
box and enter C0.

Save the Settings

In order to start the Seehau software with
these settings you need to save the con-
figuration.  From the menu bar select
CONFIG->Save Settings.  Use the
filename startup.bas, the default start-up
file name.

Figure 8. SFR window

Figure 9. Change attributes window
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Emulator Demonstration Program

Now that we have configured the emulator we will demonstrate some of the features.  We will show how to Load
Code, Setup a Shadow Memory display in ASCII and use the Watch Points to break on a complex event.

Load and Run the Timer Demo Example Program

To load the program, do the following:

1. From the Seehau File menu, click Load Code.The Open dialog box appears.

2. Double-click the OCELite folder.

3. Highlight the OCELite.abs file and click Open. You can also double-click the file name and it will load into the
emulator.

4. You can verify that the program has loaded by going to the main File menu, click Verify Loaded Code. From
the File dialog box highlight OCELite.abs and click Open.

5. Click the                  Source Step Into button on the toolbar and the program will run to the start of MAIN.
Congratulations the emulator is installed and running!

Using Shadow Memory

The EMUL-ST10-OCELite-PC emulator provides Shadow RAM. This feature allows you to view  which can be
used to observe changes to the memory while the program is executing.  When the value changes it will be high-
lighted in red.  There is an array, called show, in the OCELite.abs file that can be used to demonstrate this.  In the
Data Window (shown in figure 10) replace the default 000000 with “show” in the Address Entry Text Box.

Next click on the Space type area of the status bar and select Shadow.  Lastly click on the Format type area and
select ASCII.  Click the OK button.  The Data Window should now have C010 as the starting address and display

data in ASCII.  To observe the Shadow Memory click on the  icon on the Seehau main tool bar.  The data

should now highlight in red the values that are changing.

Figure 10. Data window Shadow RAM space
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Inspect/Watch Window

The Inspect/Watch Window is used to inspect or change variables in your program.  The Inspect/Watch Window
can be opened by selecting New -> Inspect/Watch from the main menu bar.  The window in figure 11 appears.

In the upper text box enter the name of the variable you want to inspect.  In this case type “show” and press enter.
The variable show will appear with a + sign to the left of it, indicating there are multiple elements to view.  When you
click the + sign the individual elements will be displayed.  The element that we were observing with the Shadow
RAM was element 7.

The Inspect Window can either show the values when the program is stopped at a Breakpoint or while the program
is running, by using the Shadow RAM.  To display the variable while the program is running right click on the
variable and select Update During Runtime (figure 12).

To see show update while the program is running click on the  icon and the values that are changing will be

highlighted in red.

Figure 11. Inspect window Figure 12. Update during runtime
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Emulator Configuration Screen Options

The Emulator Configuration screen is accessed from the main menu bar by selecting the Config menu and click
Emulator. The Emulator Configuration window opens.There are two tabs across the top of the main Emulator
Configuration  window.  When selected each tab allows you to:

Hdw Config - is used to configure the emulator hardware (see Figure 1).

Misc Setup -  is used for reset options.

Buttons Common to All Tabs

OK - Saves the settings for the tab and exits the dialog box.

Apply - Saves the settings for the tab.

Cancel - Exits without saving the settings for the dialog box.

Help - Displays the Seehau Help file.

Refresh - Allows you to retrieve and view the current emulator hardware configuration settings.
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Hdw Config Tab

Processor - Displays the processor you selected during the initial configuration. To change this, run Seehau Config.
Clock (MHz) - (not applicable) You can enter your value for reference only.
On Chip ROM Size - (not applicable) This box specifies the internal ROM size for the bondout only.
Emulator Memory -  (not applicable) Always indicates 256K.
CSSEL - Displays the number of chip-selects in use.
Monitor level - This combo box is used to determine the interrupt level of the monitor (0 = lowest, F = highest
level).

Bus Config

 This group of options is active only if the Port 0 Override option in the Miscellaneous group is selected.
•     WRH/BHE - If the BHE is selected, pis WR and BHE retain their normal function. If WRH is selected
WR acts as WRL, pin BHE acts as WRH.
•     8-Bit/16-Bit - Determines the size of the external data bus (8 bits or 16 bits).

- Access to the external bus is enabled if the EA/pin is held LOW during RESET. During the same time,
the width of the data bus is determined by a pull-down resistor connected to Port POH.7. This resistor
determines the setting of bit 7 in register BUSCON0 (mapped to BTYP bit 1).

* If Pull-down resistor is present: Data bus is 8 bits BTYP bit 1 is clear.
* If Pull-down resistor is absent: Data bus is 16 bits BTYP bit 1 is set.

Figure 1. Hdw Config tab from within Seehau
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- This set of options can be used to override the hardware configuration that determines the width of the
data bus. The emulator changes BTYP bit 1 according to the override specification.

•    MUX/DEMUX - Determines if the external data bus is multiplexed or de-multiplexed.

Monitor Mode Peripheral

Determines if the associated peripherals continue to run in monitor mode. Default (option cleared) indicates that the
peripherals are turned off in monitor mode. This causes the peripheral to halt upon break.

•     GPT Units - The peripherals are General Purpose Timer (GPT) units (both GPT1 and GPT2).
- The GPT units GPT1 and GPT2 represent flexible multifunctional timer structures that can be used for
timing, event counting, pulse width measurement, pulse generation, frequency multiplication and other
purposes. They incorporate five16-bit timers that are grouped into two timer blocks GPT1 and GPT2.

•     CAPCOM1 - Not applicable.
•     ADC - Not applicable.
•     SSC - The peripheral is the high-speed Synchronous Serial Interface (SSC).

- The SSC provides flexible high-speed serial communication between the ST10 and the other
microcontrollers, microprocessors or external peripherals.

•     ASC0 - The peripheral is the Asynchronous/Synchronous Serial Interface (ASC0). The ASC0
provides serial communication between the ST10 and the other microcontrollers, microprocessors or
external peripherals.
•     CAPCOM2 - Not applicable.
•     PWM - The peripheral is the Pulse Width Modulation module (PWM). The PWM module of the ST10
allows the generation of up to four independent PWM signals. The frequency range of these PWM signals
for a 20-MHz CPU clock is from 4.8 Hz up to 10 MHz for  edge aligned signals. For center aligned signals
the frequency range is 2.4 Hz up to 5 MHz.

Miscellaneous

•     External Memory - Not applicable.
•     XRam Enabled - Not applicable.
•     Boot Strap Ldr O.R. (Boot Strap Loader Override) - Not applicable.
•     Port 0 Override - Normally bus configuration is determined by pull-down resistors connected to Port
P0H. Selecting this option enables the overriding of bus configuration by software and enables the Bus
Config group of options.
•     Mask INT on step - Selecting this option disables the interrupt while single-stepping. If an interrupt
occurs while you’re single-stepping, you will end up in the interrupt service routine,. This option uses the
disable interrupt instruction to prevent jumping into this routine. Enabling and disabling the interrupts with
your code will have no affect while this option is selected.
•     Interrupts in Monitor - Enable any of the Monitor Mode Peripheral options to be serviced when the
monitor level is (lower number) than the peripheral interrupt level.

Reset Delay - Lengthens Reset Pulse by time entered (in mS), the default is 50mS.
Hot Plug - Select this option to start Seehau without resetting the target. All registers and memory content will be
maintained.
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Misc Setup Tab

Reset chip after load file - Select this option if you want to have the emulator automatically reset the MCU after
loading a code file.

Vector Table Segment  - For customers who have RAM at address 0, this feature determines at which segment the
Vector Jump Table is stored.

Override at Reset
•     Program Counter - Select this option if you wan to pre-set the program counter to a specified value
upon emulator reset.
•     Stack Pointer - Select this option if you want to pre-set the stack pointer to a specified value upon
emulator reset.

Figure 2. Emulator Configuration Misc Setup tab
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EMUL-ST10-OCELite-PC Event Information

Introduction

The EMUL-ST10-OCELite-PC has events that can be used to break execution, or generate an Event OUT signal
based on address (Instruction Execution), data address (Reads or Writes) and data value (Write only).  There are
two levels that either can be OR’d together, or one level can be conditioned by the other level or the Event IN
signal.

Event Logic

The event logic has two modes of operation: the Standard mode and Advanced mode. The event logic has two
levels of Address and two levels of data address, qualified by Read or Write,  AND’d or OR’d with a data value
(Write only).  The block diagram of the event logic is shown in  figure 1.  The arrows point to the control on the
event configuration tab that corresponds to that section of the block diagram.

Figure 1. Block Diagram
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EMUL-ST10-OCELite Event Configuration

Configuring the Event Options

To open the Event Configuration window (shown in figure 2) from the  Config menu, select Events.  This window is
for the OCELite event configuration.  This discussion is for the Advanced mode.  The Standard mode has many of
these values either not available or have unchangeable default values.  Click on the button in the bottom right-hand
corner to switch modes.

This is the view of the tab after you click the Advanced button. You are now in Advanced mode. The button label
now reads Standard. Click Standard to return to Standard mode. This is also true for the Level 2 tab.

Figure 2. Events tab displaying options for advanced mode
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There are three tabs across the top of the main Event Configuration window. When selected, each tab allows you
to:

Events - Set up event options.
Level 1 - Add and edit address and data ranges for one level.
Level 2 - Add and edit data ranges for another level.

Buttons Common to All Tabs

OK - Saves the settings for the tab and exits the dialog box.
Apply - Saves the settings for the tab.
Cancel - Exits without saving the settings for the dialog box.
Help - Displays the Seehau Help file.
Refresh - Allows you to retrieve and view the current emulator hardware configuration settings.

Events Tab

Active Levels

The status of the two levels is indicated here.  A red dot means the specified level is disabled while a green dot
indicates it is enabled.

There are two levels with two Instruction Pointer comparators and two Read or Write Address comparators,
AND’d or OR’d with a data value (Write only).  The Instruction Pointer comparator on each level has break
before make (break on compare), break now, and control of the Event OUT pin.  The data comparator has only
break now and control of the Event OUT pin.

Event IN

An external  signal can be connected through the Event IN to the event logic.  This connector is on the side of the
cable adapter.  The signal can either be latched or free floating (Direct) according to the setting selected.  The Event
IN is sampled by the clock rising edge twice before being forwarded to the logic.

Event  OUT

There is an Event OUT connector on the cable adapter that is pulsed when an event occurs in a level.
•     Set/Clear - If Set/Clear is set, the value of the Event OUT  will change according to the “Turn Event
output ON” and the “Turn Event output OFF” options in the Level tabs which are discussed later.  When
this output is turned on for instance, it will stay in this state until the Clear option occurs.  Normally two
events are used to turn the Event off and on.  This feature is mutually exclusive to the Track Trig feature.

•     Track Trig - Track Trig provides for an output pulse that is active only when the event condition is true
and the “Turn Event output ON” option is selected.  The output waveform “tracks” the state of the event.
This occurs on a cycle-by-cycle basis.
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Level 1 and Level 2
Overview

The OCELite Event provides two levels of events.  These are represented by the two level tabs in figure 3.  The
two levels are provided by the Event Logic and are controlled through the Seehau Interface.  Level 1 is shown
selected in figure 3.
The two levels are equal in priority and independent to each other unless the “Depend” box has an entry in it.
Associated with each level are two data qualifiers and two address qualifiers.  You can include the other level and
Event IN signal.

Address 1-OFF & Address 2-OFF

Each is an address or an address range that are OR’d together.  The address range can be setup by using the
address mask up to 64K.  The breakpoint options are break before make and break now.  Double-click or press
the right mouse button to enter or modify data.  The OFF shown will turn to an ON when data is entered and the
enabled boxes in the edit windows are checked.

Data 1-OFF & Data 2-OFF

Each is an address or an address range that are OR’d together.  The address range can be setup by using the
address mask up to 64K.  The address can be AND’d or OR’d with a data value (Write only).  The data mask can
be used to select only lower byte (00FF), upper byte (FF00), or word (FFFF).  The breakpoint option is break
now only.  Double-click or press the right mouse button to enter or modify data.  The OFF shown will turn to an
ON when data is entered and the enabled boxes in the edit windows are checked.

Figure 3. Level 1 tab displaying options for the advanced mode
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Repeat Counter

Each level has a 16 bit counter that essentially determines how often an event must happen before the event is
generated.  The value used in this counter is called the repeat count and is entered in the repeat counter field shown
in figures 3.   For example, if the Repeat Level Count = 4, then the event will be activated by the qualifiers becom-
ing true 4 times.  If the Repeat Counter = 0, the event will not occur.  The values entered are HEX therefore the
largest number that can be entered is FFFF.

Depend

This drop-down menu refers to the “dependency” feature.  This connects to the other level or the  Event IN con-
nector.  The default is blank or “Independent”.

Priority

When the priority check box is used the level in PSW is compared with the monitor priority level on the Emulator
Configuration Screen. The break will occur only if the PSW level is lower than the monitor priority level (see figure
4).

Figure 4. Hdw Config tab
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Edit Level Dialog Boxes

To open the Edit Level dialog box either double-click or right-click in an address line or a data line.  Clicking on an
address line opens the Edit Level dialog box for addresses (figure 5).  Clicking on a data line opens the Edit Level
dialog box for data (figure 6).

Edit Level - Address

If the enable check box is unchecked, the
qualifier will be disabled, the word OFF
will appear next to Address in the Cycle
Type column (figure 3). If you disable the
other three qualifiers, the green enable
light will go off (figure 2).
You can type the symbol name, for
example, Main, or enter direct hex
addresses.  You can also copy the
symbol name from the symbol browser
found in the Symbol Browser window.
(To open this window, from the View
menu, select Symbol Browser). Note the
various combinations that can be entered
in this window.  Examples using these
windows are given at the end of this
chapter.  The address mask can be used
to setup a range to 64K.

Edit Level - Data

If the two enable check boxes are un-
checked, the qualifier will be disabled, the
word OFF will appear next to the Data in
Cycle Type column (figure 3).
If you disable the other three qualifiers, the
green enable light will go off (figure 2).
You can type the symbol name, for ex-
ample, [show] 7, or enter direct hex
addresses.  You can also copy the symbol
name from the symbol browser found in the
Symbol Browser window. (To open this
window, from the View menu, select
Symbol Browser).  The Read and Write
options qualify the cycle type.  The data
mask can be used to select only lower byte
(00FF), upper byte (FF00), or word
(FFFF).

Figure 5. Edit Level Dialog Box for Address

Figure 6. Edit Level Dialog Box for Data
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Using Hardware Breakpoints

The hardware breakpoints set from the source or assembly windows use the event system.  There are a total of four
hardware breakpoints.  If either of the levels are being used then the number of hardware breakpoints available will
be reduced.
As an example if level 2 is being used to break on a Write than only two hardware breakpoints are available.  This is
currently detected when execution (go, step, etc.) begins.  The message states that there are not enough resources
available.

Saving the Event Configuration to a Macro

Once you have completed your event configuration, you can save it to a macro. You can create this macro manually
or use built-in macro recorder.

Creating a Macro Manually

To create a macro manually, you need to create a text file with the *.bas extension (Filename.bas). This method is
not recommended as a detailed knowledge of the macro commands will be needed. It is easier to make this *.bas
file with the macro recorder. (See the following ”Creating a Macro Using the Macro Recorder”). Manually editing
an existing file is easy and recommended with the built-in macro editor. To open the Macro window, from the
Macro menu, select Show. You can also edit a macro with any ASCII text editor.

Creating a Macro Using the Macro Recorder

The Macro menu lists two items you can use to start (Start Recording) and stop (Stop Recording) your macro
recording.  All your keystrokes will be saved to a filename.bas file of your choosing.

A macro can also be created from any tab that has an Apply button.  The present settings of the configuration menu
will be saved at one time.  This is useful for saving a series of settings that have been subsequently modified and the
exact key sequence is not available.

To save your event configuration to a macro using the Apply button, do the following:
1. Open the Events or any Level tab with the Apply button visible.
2. From the Macro menu select Start Recording.  The Event Configuration window will close.
3. Reopen the Event Configuration window by selecting Config, and then Events. Click Apply.  The settings

associated with the Event Configuration window will be saved.
4. From the Macro menu select Stop Recording. This opens the Save Macro dialog box.
5. Enter a file name for the new macro and click Save.
The macro is ready to use and will accurately recreate your configuration settings.  You can run your macro by
either creating a button for your toolbar (this feature is found under Config, Buttons) or from the Macro menu,
selecting Run.

You can also save your event configurations by selecting the Config menu, and then selecting Save Settings. This
opens the Save Settings dialog box when you can save your settings as a *.bas file.
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How to use Events

In this section we will have some practical uses for the event.  The examples will demonstrate how to use the Equal
and Mask modes.

Using the Events - Real Examples

The configuration for the Event facility is found on the main menu by selecting CONFIG->Event.  This window has
three tabs.  The Events tab is used to configure the Event IN and Event OUT, when the advanced is selected.  The
level 1 and level 2 tabs are used to configure the Event.

One use for events would be to break when a variable equals a particular value.  To demonstrate this we will use
the OCELite example program.  This program is a clock that updates every second.  The clock’s values are stored
in an array called Show used to demonstrate the Shadow RAM feature.  The sixth and seventh elements of this
array contain the seconds.  Follow the configuration steps in the next section.

How to Break When a Variable Equals a Particular Value

For this example, use the OCELite.abs.file. To open this file do the following:

1. From the File menu, select Load Code.
2. Open the Examples folder and select the OCELite folder.
3. Select ocelite.abs and click Open.

Figure 7. Example Settings for the Edit Level Dialog Box
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This program is a clock that updates every second. The clock’s values are stored in an array called show used to
demonstrate the Shadow RAM feature. The sixth and seventh elements of this array contain the seconds. To break
when the lower digit of the seconds field equals 3, do the following:

4. From the Config menu, select Event. Then select the Level 1 tab.
5. Right-click in the data line and select Edit. The Edit Level dialog box opens.
6. Enter [show] 7 in the Address text box. This indicates the seventh element of the array.
7. Enter 0x3300 in the Data text box.
8. Select the Write option (figure 7).
9. Click OK. This closes the Edit Level dialog box and opens the Level 1 tab.
10. Select BK now if level TRUE (figure 8).
11. Click the Go icon           on the Seehau main menu bar. The program should stop when show [7] equals three.
12. To verify this, look in the data location C017. It should contain 3.

Figure 8. Example Settings for the Event Tab




